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Working with Cases

Creating a New Local Case

Cases are often created through the Administration module to be available on a network. A local case can be created for one person to use. Later, it can be imported through the Administration module to make it shareable. To create a new case, follow these steps: 1. Access LiveNote to display the Open Case dialog box. Click New to display the New Case dialog box.



2. Select the drive and directory to use for storage of the case, type the file name, e.g., smith, and click Save. The New Case Properties dialog box is displayed.



3. Type the name of the case in the Name text box, e.g., Smith v Jones, and click OK. The case window, which lists all the transcripts for the case, is displayed. Note: If a case is open, you must close it before you can create a new case.



Closing a Case

You can close a case using either of the following methods:

I I



Click the Close button (



) in the upper-right corner of the case window.



From the File menu, choose Close Case.



The message Close the current case? is displayed. Click Yes to close the case. The Open Case dialog box is displayed in which you can choose another case.
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Opening a Case

If a case is open, you must close it before you can open another case. To open a case, choose Open Case from the File menu to display the Open Case dialog box. Select your case from the list and click OK. To open a secured case, complete these steps: 1. Click Secured Cases in the Open Case dialog box. The Manage Secure Case Repositories dialog box is displayed. 2. Click Logon. The Logon to [your] Repository dialog box is displayed. 3. Type your username and password and click OK. The Manage Secure Case Repositories dialog box is redisplayed. 4. Select Remember my logon settings if you want LiveNote to remember your username and password. 5. Click Close to display the Open Case dialog box. Several types of folders may be displayed: • A yellow folder indicates a local case. Only one person can access it at a time. • A brown folder with a key indicates a secure case that is currently being accessed through the network. • A blue folder with a key indicates a secure case that was replicated offline and is currently being accessed locally. 6. Select your case and click OK.
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Managing Transcripts

Creating a New Transcript

In an open case, create a new transcript using either of the following methods:

I



Click the New Transcript button on the toolbar at the bottom of the LiveNote window. From the Transcript menu, choose New.



I



The New Transcript Properties dialog box is displayed. Type the name of the deponent in the Name text box, e.g., Smith, Robert, and click OK. A new, blank transcript is displayed.



Opening an Existing Transcript

You can open a transcript using any of the following methods:

I I I



Right-click the transcript you want to open and choose Open from the menu that is displayed. Select the transcript you want to open. From the Transcript menu, choose Open. Click the transcript folder icon ( transcript icon ( ). ) to view the contents of the folder. Then double-click the



The transcript is displayed in the LiveNote window.



Deleting a Transcript

You can delete a transcript using either of the following methods:

I I



Right-click the transcript you want to delete and choose Delete from the menu that is displayed. Select the transcript you want to delete. From the Transcript menu, choose Delete.



The Delete Transcript dialog box is displayed. The Enable Undo check box is automatically selected so you can undo the deletion, if necessary. Hold down the Shift key and click OK.
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Connecting to LiveNote in Real-Time

Connecting with a Serial Connection

You can connect to a LiveNote session in real-time using serial cables. LiveNote cabling requires a serial port on your computer. If you have only a USB port available, you will need to provide a USB to serial adapter. If a USB to serial adapter is not available, you can connect to the LiveNote session over the Internet via LiveNote Stream. Contact the court reporter to schedule the session. The court reporter must notify LiveNote 24 hours in advance if you want to use LiveNote Stream. To connect to a real-time session using serial cables, complete these steps: 1. Open a new transcript. 2. Click the Connect button on the toolbar at the bottom of the LiveNote window to display the Connect to Realtime dialog box. 3. Select Serial. The court reporter will give you the necessary settings for connecting to the reporter’s CAT (computer–aided transcription) system. You will need to know the required serial port setting. 4. Click Connect to connect to the real-time session.
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Connecting with LiveNote Stream

LiveNote Stream allows you to connect to a LiveNote real-time session via the Internet. Contact the court reporter to schedule the session. The court reporter must notify LiveNote 24 hours in advance if you want to use LiveNote Stream to view transcript text or 72 hours in advance to view video and text. LiveNote will send you an e-mail with the required username and password. You can access LiveNote Stream through LiveNote or through Microsoft Internet Explorer. Connecting Through LiveNote To connect to a LiveNote Stream session through LiveNote, complete these steps: 1. Open a new transcript. 2. Click the Connect button on the toolbar at the bottom of the LiveNote window to display the Connect to Realtime dialog box. 3. Select LiveNote Stream and click Connect to display the Login dialog box. 4. Type the username and password sent to you by LiveNote and click OK to display the Sessions dialog box. 5. Select the session you want to attend and click OK.



Connecting Through Internet Explorer You do not need LiveNote software to access LiveNote Stream through Internet Explorer. To access LiveNote Stream on the Internet, complete these steps: 1. Go to www.livenote.com/stream. 2. Type the username and password sent to you by LiveNote and click Go to display the Sessions dialog box. 3. Select the session you want to attend and click OK. The realtime deposition transcript text and video are displayed.
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Working with a Transcript in Real-Time

LiveNote provides you with tools that are easy to use even when you are working with a real-time transcript in a live deposition. You can stop and start the scrolling text, annotate the text, and do quick word searches at the same time that you are listening to what the deponent is saying. You can also annotate and search existing transcripts.



Starting and Stopping Text

To stop the scrolling real-time transcript while in a deposition, press the Esc key or click the Stop button on the toolbar at the bottom of the LiveNote window. The line currently being transcribed is completed and the scrolling transcript pauses. To browse the text of the transcript, you can use the scroll bar on the right or press the Page Up and Page Down keys or the arrow keys on your keyboard. Pressing Ctrl+Home will take you to the top of the text; pressing Ctrl+End will take you to the end of the text. To restart the scrolling transcript, press the Esc key or click the Continue button on the toolbar at the bottom of the LiveNote window.



Using Quick Marks

Quick Marks are marks at the line number in the margin of a transcript. They are the simplest form of annotation in LiveNote and are displayed as a solid bar in the default Quick Mark color. You can use them as place markers in the text for which you can run searches and generate reports. To insert a Quick Mark, press the spacebar on your keyboard or click a line number. A complete list of all Quick Marks in a transcript is located in the Quick Marks folder under the transcript in the case window. Click the Quick Marks folder to open it. Double-click a Quick Mark reference in the folder to jump to the Quick Mark in the transcript. To delete a Quick Mark, click it in the margin of the transcript.



Press the spacebar or click a line number to place a Quick Mark in the margin of the transcript.



Double-click a Quick Mark reference in the Quick Marks folder to jump to its location in the transcript.
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Using Issue Marks

An Issue Mark is a mark at the page and line number in the margin of a transcript that corresponds to a particular issue on the Issue bar. The Issue Mark color is the same as the color of the issue. To insert an Issue Mark, press the number key on your keyboard that corresponds to the number assigned to the issue on the Issue bar. A complete list of all Issue Marks is located in both the Quick Marks folder and the Issues folder in the case window. You can view the issues by category in the Issues folder. Click the Quick Marks or Issues folder to open it. Double-click an Issue Mark reference in the folder to jump to the Issue Mark in the transcript. To delete an Issue Mark, click it in the margin of the transcript.



Press the number key that corresponds to the number associated with the issue on the Issue bar to place an Issue Mark in the margin of the transcript. Double-click an Issue Mark to jump to its location in the transcript.



Managing Annotations

An annotation is a highlighted portion of the transcript text. It may be associated with an issue, a note (a comment associated with an annotation), or an attachment, e.g., a document or image. Adding an Issue Annotation Using the Issue Bar To add an annotation associated with an issue using the Issue bar, complete these steps: 1. Click the Auto Annotation button ( ) on the Issue bar to cancel its selection.



2. Click an issue button on the Issue bar to select the issue and assign it to the annotation you are adding. 3. Select the text you want to annotate. The text is highlighted with the color of the issue you selected. The issue will be assigned to every annotation you create until you cancel its selection on the Issue bar.



Note: You can select more than one issue on the Issue bar. Annotated text will be highlighted with the color of the issue that is first in alphabetical order.
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Adding Issues, Notes, and Attachments Using the Annotate Dialog Box To add an annotation associated with an issue, note, attachment, or a combination of these, complete these steps: 1. Make certain the Auto Annotation button ( ) on the Issue bar is selected. (This is the default setting.)



2. Select the text in the transcript you want to annotate. The Annotate dialog box is displayed. 3. The Issues tab in the Annotate dialog box displays the prioritized list of issues. To assign one or more issues to the annotation, select the appropriate check boxes. Note that the check boxes for any issues you previously selected on the Issue bar are already selected. If an issue has not been prioritized (does not appear on the Issue bar), it is listed in the Other list box. To assign a non-prioritized issue, select it in the Other list box. To prioritize the issue, rightclick it and drag it next to a number. 4. To add a note to the annotated text, click the Note tab and type your note in the text box. 5. To add an attachment to the annotated text, click the Attachment tab. You can add any type of file that can be opened on your computer. Click Browse to display the Find Attachment dialog box. Select your document and click Open. When you add an attachment, a paper clip icon ( ) is displayed in the margin next to the annotated text. 6. Click OK to save the annotation. The annotated text is highlighted with the color of the issue you selected. If you did not select an issue, the text is highlighted with the default annotation color. Note: The tab last used for adding an annotation will be displayed in the Annotate dialog box when you add the next annotation.

Adding New Issues



To add a new issue to the existing list of issues, click New Issue on the Issues tab. The New Issue dialog box is displayed. Type the name of the issue in the Issue text box and click OK.

Associating Video with an Annotation



If the transcript has been synchronized with video footage, a Video tab is available in the Annotate dialog box. You can adjust the start and end points of the video segment associated with the annotation.

Transferring Annotations



To transfer the annotation to another application such as JFS Litigator’s NoteBook or TrialDirector, click Transfer to display the Transfer Target dialog box. Select the application and click OK.

Sending Annotations to Instant Messages



To send an annotation to a team member during an instant messaging session, click Message. The Message button is available only when you are connected to an instant messaging session.
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Editing Annotations To change the information associated with an annotation, right-click in the annotation and choose Edit from the menu. The Edit Annotation dialog box is displayed. Deleting Annotations You can delete an annotation using either of the following methods:

I



Right-click in the annotation and choose Delete from the menu. The message Delete this annotation? is displayed. Click Yes. Click in the annotation and then press the Delete key. The message Delete this annotation? is displayed. Click Yes.



I



Viewing Annotations To view the details of an annotation you or another user made in the transcript, right-click in the annotation and choose View from the menu. The View Annotation dialog box is displayed. You can view the following details:

I I I I I



the page and line numbers in the transcript text where the annotation starts and ends a list of any issues attached to the annotation the text of any note attached to the annotation the path and name of the any file attached to the annotation the full name or username of the author (secure cases only)



Viewing an Annotation Attachment You can view an annotation attachment using either of the following methods:

I I



Right-click in the annotation and choose Open Attachment from the menu. Double-click the paper clip icon in the margin of the transcript next to the annotation.



Changing the Start and End Position of Annotations You can change the amount of transcript text included in an existing annotation by changing its start or end position. To change the start position, hold down the Ctrl key and click in the annotation near its start. Drag the pointer upward to include more text in the annotation. Drag the pointer downward to include less text in the annotation. To change the end position, hold down the Ctrl key and click in the annotation near its end. Drag the pointer downward to include more text in the annotation. Drag the pointer upward to include less text in the annotation.
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Using the Word Wheel

The Word Wheel contains an index of words and numbers with their corresponding page and line numbers in the transcript. When you are connected to a real-time session, the Word Wheel is updated every 15 seconds. Use the Word Wheel to search for a word or number in the transcript. Type the word or number in the text box on the left side of the LiveNote window to display the pages and lines where the word or number is found in the transcript. To see the word or number in context, hold your pointer over the page and line reference. The question and answer in which the word or number appears is displayed. To display the word or number in the transcript, click the page and line reference.

Type the word or number you want to search for in the Word Wheel text box. Hold your pointer over the page and line reference to see your word or number in context. Click the page and line reference to view your word or number in the transcript.



Selecting Word Wheel Options To select Word Wheel options, choose WordWheel from the Options menu. The WordWheel Options dialog box is displayed. You can change the Word Wheel settings to specify

I



whether the Word Wheel is automatically displayed with transcripts. whether you want words or numbers listed in the Word Wheel index when they are mentioned more than a certain number of times in the transcript. how much transcript text you want displayed when viewing a word or number in context in the Word Wheel window. If you select QA Pair, the entire question and answer in which the word or number appears is displayed. In the alternative, you can designate the number of lines to be displayed above and below the word or number.



I



I



Click OK to save the Word Wheel settings.
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Creating Auto Tags

Use Auto Tags to automatically highlight words or phrases as they appear in the transcript. You can create an Auto Tag using either of the following methods:

I



Click the Auto Tags button on the toolbar at the bottom of the LiveNote window to display the Auto Tags dialog box. From the Annotate menu, choose Auto Tags to display the Auto Tags dialog box.



I



For each word or phrase you want to add, complete these steps: 1. Click Add to display the Add Keyword dialog box. 2. Type the word or phrase you want to add to the Auto Tags list. You can use the asterisk (*) at the beginning or end of a word to include variations of the word. Then click OK. The word or phrase is added to the list in the Auto Tags dialog box. 3. Select the Show Auto Tags check box to highlight Auto Tags in transcripts. 4. Click OK to save your changes. Your Auto Tags will be highlighted automatically throughout the transcript.



Auto Tags dialog box



Add Keyword dialog box



Transcript with highlighted Auto Tags



Managing Auto Tags

Showing and Hiding Auto Tags If you choose not to show Auto Tags when you create them, you can show them by choosing Show Auto Tags from the Annotate menu. To hide Auto Tags, choose Show Auto Tags again. Deleting Auto Tags To delete an Auto Tag, complete the following steps: 1. From the Annotate menu, choose Auto Tags to display the Auto Tags dialog box. 2. Select the word or phrase you want to remove and click Delete. 3. Repeat step 2 for each word or phrase you want to delete. 4. Click OK to save your changes.
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Creating Reports

Reports can be generated for all annotations, Quick Marks, issues, notes, attachments, cases, queries, and Auto Tags. While viewing an Annotations, Issues, or Quick Marks report, you can return to the location in the transcript where the annotation or mark appears by double-clicking its section in the report. or choosing the transcript from the Window menu. To return to the report, press Ctrl+Tab or choose it from the Window menu. New annotations are automatically added to the report as you create them, so the report is always current. Annotations Report You can generate a report that includes a list of all the annotations in a transcript, arranged in page and line order. It also includes the surrounding questions and answers. You can create an Annotations report using either of the following methods:

I I



From the Report menu, choose All Annotations. Right-click the All Annotations folder in the case window and click View Report.



Right-click the All Annotations folder, then click View Report to create an Annotations report.



Verbatim Digest Report This is an Annotations report that includes only highlighted transcript text. To create a Verbatim Digest report, first create an Annotations report. Then click Options at the top of the report window to display the Annotations Report Options dialog box. Clear all check boxes except Show Text, then click OK. Quick Marks Report This report lists all Quick Marks and Issue Marks in a transcript, arranged in page and line order. To create a Quick Marks report, right-click the Quick Marks folder in the case window, then click View Report. In the alternative, from the Report menu, choose Quick Marks to display your report, which includes the lines you marked and the surrounding questions and answers. Issues Report This report lists all of the issues in a transcript, grouped by issue and then arranged in page and line order. To create an Issues report, right-click the Issues folder in the case window, then click View Report. In the alternative, from the Report menu, choose Issues to display your report, which includes the lines you marked and the surrounding questions and answers. Notes Report This report lists all of the annotations in a transcript that have a note, arranged in page and line order. To create a Notes report, right-click the Notes folder in the case window, then click View Report. In the alternative, from the Report menu, choose Notes to display your report.
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Attachments Report This report lists all of the annotations in a transcript that have an attachment, arranged in page and line order. To create an Attachments report, right-click the Attachments folder in the case window, then click View Report. In the alternative, from the Report menu, choose Attachments to display your report. Case Report This report includes the name of the transcript and any comments about the transcript. To create a Case report, from the Report menu, choose Case. Query Report This report lists the result retrieved when you run a search using the Full Text Query feature. To create a Query report, from the Report menu, choose Full Text Query. See pages 19 to 24 for information on creating queries. Auto Tag Report This report lists all occurrences of the words and phrases in a transcript for which Auto Tags were created, arranged in page and line order. To create an Auto Tag report, from the Report menu, choose Auto Tag Query.



Customizing Reports

Reports can be customized using the buttons at the top of the report window.



Using Options To refine your report, click Options to display the Report Options dialog box for the type of report you are viewing. All options for a report are automatically selected. Clear the check boxes for any options you do not want to include. Select the Lines Above/Below check box and designate the numbers of lines to include a specific number of lines above and below the annotations in the report. Click OK. Adding Transcripts To add one or more transcripts to a report, click Transcripts to display the Report Transcripts dialog box. The current transcript is automatically selected. Select the other transcripts you want to add to the report. In the alternative, click Select All to select all transcripts. Click OK. Refining Issues To limit your report to a particular issue, click Issues to display the Report Issues dialog box. All issues are automatically selected. To remove an issue from the report, clear its check box or cancel its selection in the Other list box. Click OK. Transferring Reports To transfer the report to another application, such as JFS Litigator’s NoteBook or TrialDirector, transfer options must be enabled. From the Options menu, choose Transfer to display the Transfer Options dialog box. Click the tab that corresponds to the program you want to transfer your report to and select the Enabled check box. Click OK. In the report window, click Transfer to display the Transfer Target dialog box. Select the desired application and click OK.
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Managing Issues

An issue is a type of annotation that relates to a particular subject. Categorizing testimony by issue makes it easy to retrieve all testimony on a specific subject when you need it. Issues are created only once for each case and are the same for all users of that case.



Creating Issues

To create an issue, complete the following steps: 1. From the Issue menu, choose New to display the New Issue dialog box.



2. Type the name of the issue in the Issue text box, e.g., Employment History. 3. Select the Redisplay Dialog check box if you are creating multiple issues. 4. Click Change to display the Color dialog box. 5. Select a color and click OK. 6. Click OK in the New Issue dialog box.



Prioritizing Issues

The Issue bar enables you to access issues quickly when creating annotations. You can display up to 10 issues on the Issue bar. Although the issues in a case are the same for all users, each user can choose the issues to display on the Issue bar.



Issue bar



To prioritize an issue and add it to the Issue bar, complete the following steps: 1. From the Issue menu, choose Current to display the Current Issues dialog box. 2. Click the arrow in the first text box to display a list of the issues in the case. 3. Select an issue, e.g., Photograph. This issue is assigned to the number 1 in the priority list and is added to the Issue bar.
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4. Repeat steps 2 and 3 for each issue. You can prioritize up to 10 issues. Click OK when you finish prioritizing the issues.



You can also drag an issue in the All Issues list box to a text box to prioritize it.



Importing Issues

You can create a list of issues in any word-processing program that can save files as ASCII (text only) files. Type each issue on a separate line. To import issues from a file, complete the following steps: 1. From the Issue menu, choose Import. The Import Issues dialog box is displayed. (If you have CaseMap installed, the Import Issues Source dialog box is displayed. Select File and click OK to display the Import Issues dialog box.) 2. Select the text file containing the issues you want to import and click Open. A second Import Issues dialog box is displayed. 3. Select each issue you want to import into the current case. Click Select All to select all issues. Click Deselect All to cancel your selection. 4. Click OK. The issues are added to your current list of issues.



Exporting Issues

To export issues from a file, complete the following steps: 1. From the Issue menu, choose Export. The Export Issues dialog box is displayed. 2. Select the issues you want to export. Click Select All to select all issues. Click Deselect All to cancel your selection. 3. Click OK. A second Export Issues dialog box is displayed. 4. Select the folder in which you want to save the issues file. 5. Type the name of the file that will contain the exported issues. 6. Click Save.
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Working with Transcript Groups

Transcripts can be arranged into groups. For example, you could create groups based on the different types of witnesses in a case, such as defense witnesses, expert witnesses, and plaintiff witnesses. You can select a group when you are preparing reports or creating searches to ensure all transcripts you need are included.



Creating a Transcript Group

To create a transcript group, complete these steps: 1. From the Transcript menu, choose Groups. The Transcript Groups dialog box is displayed. 2. Click New to display the New Transcript Group dialog box. 3. Type the name of the group, e.g., Defense Witnesses, in the Name text box. 4. Select the transcripts for the group in the Transcripts list and click OK. 5. Click OK in the Transcript Groups dialog box.



Editing Transcript Groups

To add transcripts to a group or remove them from a group, complete these steps: 1. From the Transcript menu, choose Groups. The Transcript Groups dialog box is displayed. 2. Select the group you want to edit and click Edit. The Edit Transcript Group dialog box is displayed. 3. Select the new transcripts to be added or cancel the selection of the transcripts to be removed and click OK. 4. Click OK in the Transcript Groups dialog box.
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Using Transcript Groups in Reports

To create a report using transcript groups, complete these steps: 1. From the Report menu, choose the type of report you want to create, e.g., Issues. A report is created for the current transcript. 2. Click Transcripts at the top of the report to display the Report Transcripts dialog box. 3. Click Select Group to display the Select Transcript Group dialog box. 4. Select the group or groups you want to include in the report and click OK. The transcripts in that group are automatically selected in the Report Transcripts dialog box. 5. Click OK to create the report.



Using Transcript Groups in Searches

You can search for annotations or run full text queries using transcript groups. To conduct a search using transcript groups, complete these steps: 1. From the Search menu, choose Find Annotations or Full Text Query. The Find Annotations or Full Text Query dialog box is displayed. 2. Click Transcripts to display the Transcripts dialog box. All transcripts are automatically selected. In order to use transcript groups, click Deselect All to cancel the selection. 3. Click Select Group to display the Select Transcript Group dialog box. 4. Select the group or groups to include in your search and click OK. The transcripts in the group or groups are automatically selected in the Transcripts dialog box. 5. Click OK to return to the Find Annotations or Full Text Query dialog box to continue your search.
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Searching with Full Text Query

The Full Text Query function enables you to search one or more transcripts in the current case for specific terms. You can search the transcript text as well as annotations, including notes and attachments.



Creating a Full Text Query

To create a query, complete these steps: 1. Display the Full Text Query dialog box using either of the following methods:

I I



Click the Full Text Query button on the toolbar at the bottom of the LiveNote window. From the Search menu, choose Full Text Query.



2. To limit your search to specific transcripts, click Transcripts to display the Transcripts dialog box. By default, all transcripts are searched. Cancel the selection of any transcript you do not want to search. 3. Select the items you want to search in the Search box. All items in a transcript are automatically selected. Clear the check boxes for items you do not want to search. 4. The Auto Preview check box is automatically selected so you can see a list of the transcripts that contain a result (hit) list for your query as you are creating it. This may slow down searches in very large cases. If you clear this check box, you can click Preview Query to see the result.
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5. Formulate a query using any of the following methods:

I



Type your query in the Query text box. You can add proximity operators, Boolean operators, wildcard operators, numeric operators, and the LIKE operator to formulate a search. See “Using Full Text Query Operators” on the next page. Click the arrow in the Query text box to select a query from a list of previous queries. Right-click a term in the Vocabulary list and select it from the menu. You can also use this menu to add operators to your query..



I I



I I



Double-click a term in the Vocabulary list to add it to the Query text box. Click Import Queries to import queries from a file. Click Help for more information on this feature.



6. To indicate how near to each other the terms in the Query text box must be, type near between the terms, e.g., transcript near public; then move the Nearness scroll box until you retrieve a satisfactory result. By default, Nearness is set to five words. You can also specify the exact distance between terms using proximity operators. See “Using Full Text Query Operators” on the next page. 7. Move the Fuzziness scroll box to indicate how closely the spelling of the terms in the Query text box must be to the spelling of the terms in the case index. By default, Fuzziness is set to zero percent, which indicates words in the Query text box must match the terms in the case index exactly. 8. Click OK. The result is displayed in the Query window on the lower-left side.
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Using Full Text Query Operators

You can add proximity operators, Boolean operators, wildcard operators, numeric operators, and the LIKE operator to formulate a query. Proximity Operators You can use the following proximity operators in your query: (Note: There is no after proximity operator. Reverse the words and use before.) Use this operator before near To find both terms when the first term precedes the second term by n terms (where n is the number on the Nearness scroll bar) both terms when the first term is within n terms of the second term (where n is the number on the Nearness scroll bar)



Use the Nearness scroll bar to to indicate how near the terms must be to retrieve a satisfactory result. By default, Nearness is set to five terms. You can also modify a proximity operator to specify distance by word (w), line (l), sentence (s), or page (p).

Examples of queries using proximity operators

I



intersection near car—finds intersection within n terms of car (where n is the number on the Nearness scroll bar) eastbound before lane—finds eastbound when it precedes lane by n terms (where n is the number on the Nearness scroll bar) intersection near17w car—finds intersection within 17 words of car intersection near5l car—finds intersection within five lines of car intersection near1s car—finds intersection in the same sentence as car



I



I I I



Boolean Operators You can use the following Boolean operators in your query: Use this operator and or not

I



To find all occurrences of each term if both terms appear in the transcript all occurrences of each term if either terms appears in the transcript all occurrences of a term if the second term does not appear in the transcript



Examples of queries using Boolean operators



intersection and car—finds all occurrences of intersection and car if the transcript contains both intersection and car intersection or car—finds all occurrences of intersection and car if the transcript contains either intersection or car intersection not car—finds all occurrences of intersection if the transcript does not contain car



I



I
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Wildcard Operators You can use the following wildcard operators in your query: Use this operator * ? [] To find all variations of a root term terms with one or more variable characters terms with one of the specified characters. Specify individual characters, e.g., [aei], or a range of characters. e.g., [a-d]



Examples of queries using wildcard operators

I I I I



walk*—finds terms beginning with walk such as walk, walked, walking, and walkway *rate*—finds terms with rate in the middle such as desperate, separated, and demonstrated advi?e—finds both advice and advise ??self—finds both myself and itself but not yourself or herself



Numeric Operators You can use the numeric operators to search for numbers in a transcript. The following numeric operators are available: Operator < > <= >= = <x and >x

I I I I



Description less than greater than less than or equal to greater than or equal to equal to not equal to



Examples of queries using numeric operators



<1000—finds numbers less than 1,000 >1000—finds numbers greater than 1,000 california > 92508—finds the term california followed by a number greater than 95208 <7770 and >7770—finds all numbers except 7770



LIKE Operator Use the LIKE operator to find terms that are synonyms for the term you specify. For example, if you use like car in your query, you will retrieve occurrences car and automobile. The global thesaurus and case thesaurus contain lists of terms that have been defined as having the same meaning. You cannot add terms to the global thesaurus, but you can them to the case thesaurus.
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Advanced Queries A query can combine different operators and multiple terms. This allows you to narrow or broaden your search so you retrieve explicit results. Full Text Query operators are processed in the following order: * like not or near and For instance, in the following queries auto or car is processed first, followed by and drive: auto or car and drive drive and auto or car Queries containing operators at the same level are processed from left to right. For example, in the following query drive before car is processed first, followed by near suspect: drive before car near suspect The order of processing can be changed using parentheses. For example, the default left-to-right processing is overridden in the following example because the operator in parentheses is processed first: drive before (car near suspect) When you compose a query containing more than one operator, it is recommended that you use parentheses to ensure that the query is processed in the desired manner.

Examples of advanced queries: Example 1: gucci or bag near limousine or like car



? numeric operators before



The query locates Gucci or bag. LiveNote then searches for either of these terms near limousine or any term that is a synonym for car. The number of terms between Gucci or bag and limousine or car is determined by the position of the Nearness scroll box. Because of the order of processing, this query is equivalent to (gucci or bag) near (limousine or like car)

Example 2: like car near1s stop* or block*



This query finds car or any synonym of car, e.g., auto, in the same sentence as s stop or any term beginning with stop (such as stopped) or block or any term beginning with block (such as blocked or blocking). Because of the order of processing this query is equivalent to (like car) near1s (stop* or block*)
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Using the Query Window

I



Click a transcript folder in the Query window to see a list of the places in the transcript where your terms appear. Click Query to redisplay the Full Text Query dialog box. You can create a new query or refine the current query. Click Transcripts to change the transcripts that are listed in the Query window. Click Report to create a report for the query Click Prev Hit to display the previous occurrence of your search terms. Click Next Hit to display the next occurrence of your search terms. Click the Close button ( ) in the upper–right corner of the Query window to close it.



I I I I I I
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Updating Transcripts

LiveNote transcripts can be updated using the following types of files:

I I



ASCII (text only) files—files containing transcript text, usually received from the court reporter Portable Transcript files (PTF)—files containing transcript text and annotations, usually received from another LiveNote user LiveNote Evidence Format files (LEF)—files containing transcripts, exhibits, exhibit links, and possibly synchronized video



I



Any annotations, including Quick Marks and Issue Marks, are automatically transferred to the updated transcript. No work product will be lost because all annotations are linked to the transcript text, not to the page and line references. Therefore, annotations made in the old transcript are simply transferred to the same text location in the updated transcript. Begin the updating process using any of the following methods:

I I



Right-click the transcript you want to update and choose Update from the menu. Select the transcript you want to update and click the Update Transcript button on the toolbar at the bottom of the LiveNote window. Select the transcript you want to update. From the Transcript menu, choose Update.



I



The Update Transcript dialog box is displayed.



Updating with an ASCII File

1. Select the ASCII file that was sent to you and click Open. (Different CAT systems create different extensions on ASCII files.) A second Update Transcript dialog box is displayed. 2. By default, Replace existing text with new text is selected. This is the correct selection for updating with an ASCII file. 3. Click OK. A second, updated file is created. The original transcript has [draft] after the transcript name. You can delete the draft copy.
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Updating with a PTF File

Use this method when you want to merge two sets of annotations into one transcript when replication is not available. 1. Select the PTF file and click Open. A second Update Transcript dialog box is displayed. 2. In the Text Update Options section, Replace existing text with new text is automatically selected. If you want to merge annotations and there are no changes to the text, select Don’t replace existing text. 3. In the Annotation Update Options section, Add new annotations to existing annotations is automatically selected. This is the correct selection for merging the annotations. 4. Click OK. A second, updated file is created. The original transcript has [draft] after the transcript name. You can delete the draft copy.



Updating with a LEF File

LEF files can contain the transcript with exhibit files and links to exhibit references in the transcript, the transcript with exhibit files and links to exhibit references in the transcript and synchronized video, or the transcript with synchronized video but no exhibits or exhibit links. 1. Select the LEF file and click Open. A second Update Transcript dialog box is displayed. This dialog box will vary depending on the file format used to create the LEF file.*

I



If the LEF file was created using an ASCII file and contains linked exhibits, the Update Transcript dialog box indicates there are exhibits in the file. You can choose whether or not to import the exhibits. If the LEF file was created using a PTF or MDB file and contains linked exhibits, the Update Transcript dialog box indicates there are exhibits in the file. You can choose whether to import the exhibits. A LEF file made with PTF/VID or MDB will also contain synchronized video. During the creation of the LEF file, you can choose whether to include the video in the file. You can also choose whether to update annotations.



I



2. Click OK. A second, updated file is created. The original transcript has [draft] after the transcript name. You can delete the draft copy.

* The file formats that may be used to create a LEF file are ASCII, PTF, PTF/VID (contain video files synchronized using LiveNote Video Sync), and MDB (synchronized file format of CT Summation). Other synchronization programs can also create the MDB format.
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Transferring Transcript Text Using the LiveNote Clipboard

Use the LiveNote clipboard to copy transcript text from LiveNote and paste it into other applications. The following details are transferred with the text:

I I I



name of the transcript page number (or numbers if copied text spans more than one page) line numbers



To transfer transcript text, complete the following steps: 1. Click the Copy to Clipboard button ( 2. Click the Auto Annotation button ( 3. Select the text you want to copy. 4. Open another application and paste the text you have copied. For example, to paste the text into Microsoft Word, press Ctrl+V or choose Paste from the Edit menu. ) on the Issue bar to select it. ) on the Issue bar to cancel its selection.



Using Issues to Create an Errata Report

The deponent has the option of reviewing the transcript after the deposition. If the deponent finds errors in the transcript, you can easily mark those places in the transcript and create a report. To create an Errata report, complete these steps: 1. Create an issue named Errata (see page 15, “Creating Issues”) and prioritize it so it appears on the Issue bar. 2. Make certain the Auto Annotation button ( 3. Click Errata on the Issue bar to select it. 4. Select the text in the transcript that the deponent reports is in error. The Annotate dialog box is displayed. 5. Click the Note tab. Type any information regarding the error in the text box, e.g. Witness says name should be Joan, not John. Click OK. 6. Click the Issues folder in the case window. Right-click the Errata folder and then click View Report. A report of the error and the note is displayed. ) on the Issue bar is selected.
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Working with Annotations and Video

Playing Annotation Video Segments

If the transcript you are viewing has a video associated with it, you can view the portion of the video that is synchronized with an annotation. Click anywhere in the annotation, then view the video by using one of the following methods:

I I I



From the Transcript menu, choose Play Video. Press Ctrl+L. Click the Play Video button on the toolbar at the bottom of the LiveNote window.



Transferring Annotation Video Segments

If a transcript has been synchronized with video, you can convert the transcript text to a video segment and save it. You can create a single video segment from a single annotation or create multiple video segments from an Annotations report. Creating a Video Segment from a Single Annotation To create a single video segment from an annotation, complete these steps: 1. Double-click an annotation in the case window. The highlighted annotated text is displayed. 2. Right-click in the annotation. 3. From the menu that is displayed, choose Transfer. Then choose Video File from the submenu. The Save As dialog box is displayed. 4. Click Save. The message Would you like to view the new video clip now? is displayed. 5. Click Yes to view the video segment. Creating Multiple Video Segments from an Annotations Report To create multiple video segments from an Annotations report, complete these steps: 1. In the case window, right-click the All Annotations folder, then click View Report. The Annotations report is displayed. 2. Click Transfer at the top of the report to display the Transfer Target dialog box.



29



Working with Annotations and Video



3. Select Video File, then click OK. The Save As dialog box is displayed. 4. Click Save. The message Video files saved successfully. Would you like to open the containing folder now? is displayed. 5. Click Yes to open the folder in which the video segments are stored. The page and line ranges are added to the video segments.



Transferring Annotations to Microsoft PowerPoint

You can transfer annotations and video segments to Microsoft PowerPoint and have them embedded in PowerPoint slides. Each annotation creates a separate slide. You can create a slide from a single annotation or multiple slides from an Annotations report. Notes: It is recommended that you use short annotations for each PowerPoint slide. If you need a longer excerpt, transfer multiple annotations from a report to create a single PowerPoint presentation with a slide for each annotation. Also, when you transfer annotations to PowerPoint from transcripts with associated videos, you have the option of saving both the PowerPoint file (.ppt) and the video clip (.mpg). If you want to share the PowerPoint presentation with someone else, you must include the associated .mpg file for the embedded video to play. Creating a PowerPoint Presentation from a Single Annotation To create a PowerPoint presentation from an annotation, complete these steps: 1. Double-click an annotation in the case window. The highlighted annotated text is displayed. 2. Right-click in the annotation. 3. From the menu that is displayed, choose Transfer. Then choose PowerPoint from the submenu. The Save As dialog box is displayed. 4. Click Save. The message Would you like to view the presentation now? is displayed. 5. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close PowerPoint.
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Creating a PowerPoint Presentation from an Annotations Report To create a PowerPoint presentation from an Annotations report, complete these steps: 1. In the case window, right-click the All Annotations folder, then click View Report. The Annotations report is displayed. 2. Click Transfer at the top of the report to display the Transfer Target dialog box.



3. Select PowerPoint, then click OK. The Save As dialog box is displayed. 4. Click Save. The message Would you like to view the presentation now? is displayed. 5. Click Yes to view the PowerPoint presentation. To create another PowerPoint presentation, close PowerPoint. Saving PowerPoint Files with the Same Name If you save a PowerPoint file with a name that already exists, the Existing PowerPoint File dialog box is displayed. Select Append slides to existing presentation to add slides to the existing presentation.
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Appendix

Prompts and Messages for Video and PowerPoint

You may receive the following warnings and error messages when transferring files as video or to PowerPoint.

The file [PowerPoint file name] already exists. Do you want to append slides to existing presentation [or] overwrite existing file?



In most cases you will want to append or add slides to the existing PowerPoint presentation. Refer to “Transferring Annotations to Microsoft PowerPoint” for more information.

The file is open in PowerPoint. Please close PowerPoint and retry.



PowerPoint needs to be closed when you are creating a presentation or appending slides to an existing presentation.

The folder already contains file named [video file name]. Would you like to replace this file?



This error usually occurs when you try to transfer the same annotation twice or when you try to save over an existing PowerPoint presentation. If you do not want to replace the file, you can cancel the transfer and review the annotation to make sure nothing has changed and then resave the file, or you can save the file to a different folder.

Synchronized video is not associated with this transcript.



The message is saying the video has not been synchronized with the transcript. A synchronized video is a video that plays in sync with the transcript; that is, as the person in the video speaks, the transcript scrolls and highlights the spoken text. A utility (for example, RealLegal Publisher) must be used to synchronize the video with the transcript; otherwise, the video plays and the transcript does not scroll.

Video does not exist for this transcript.



No video is associated with the transcript. You can transfer an annotation to PowerPoint, but not video.

Cannot create clip from annotation that spans more than one media file.



This is a catch-all error message designed for unsupported scenarios. Please contact Technical Support at 1-800-290-WEST (1-800-290-9378) and describe what you were doing when this error occurred.

Video clips can only be created from MPEG and WMV video files.



LiveNote only supports specific types of video files. For example, you cannot create video clips from RM (RealMedia) or AVI (Audio Video Interleave) files.

Failed to create temporary PowerPoint template file! Error code %d.



The above error may occur when your hard drive is full or if you do not have access rights to the hard drive where you are attempting to transfer the file.

In order to create PowerPoint slides, you must first install PowerPoint on this computer.



PowerPoint must be installed before you can transfer annotations to PowerPoint.
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